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Easy Start Guide 
Hold’em Bot  

 

 

 
These easy-start instructions assume you are using a standard Windows PC with 
English/US Windows language set and a PC Display setting of 100% (not 125%). To 
set the Windows language and Display setting please see here. Please note that our 
bot uses the Windows download poker client for all platforms and that mobile 
versions in emulators (such as Bluestacks, LDplayer, etc.) are not supported. 
 
If you use a dual monitor, please disconnect the second monitor from the tower 
entirely. If you use a laptop, please only use the laptop screen. TV screens and touch-
screen hybrid “convertible” laptops are also problematic and usually won’t work. 
 

Step 1. Open the bot by double-clicking the program shortcut holdembot (or 

holdembot.exe) on your desktop. If you did not allow the desktop shortcut to be 
installed, see here. 
 
This is what the bot looks like after you open it: 
 

 
 

 

https://bonusbots.com/


Step 2. Choose a playing style by selecting a “profile” for the bot, by first clicking 

on Holdem in the upper left, then on the submenu item Read profile: 

 

 
 
A window will open showing the available profiles we include in the download. Click 
on one. Then select Open at the bottom of the window to load it in the bot. They are all 
good, but play different styles. You should first test your setup by using the xtestonly 
profile (which will bet and raise aggressively preflop and on the flop with any hand) to 
make sure the bot’s functions for betting and raising are working properly. Once 
verified, we suggest you change to 6pack if you want an aggressive cash game profile 
or the MTT profile if you want a smart tournament profile that manages its stack well. 
For more info on how these individual profiles play see here. 
 

 
 

 
 
 



 
Your profile is now loaded as you can verify from the confirmation message in the 
bot that the profile was read. 
 

 
 

 

 
 
 

Step 3. Poker Room Software Settings must be set a certain way, from the 

lobby, in order for the bot to read the table correctly. Click below for the specific 
settings adjustments for your platform: 
 
 
 
Ignition Casino, Bovada, & Bodog Poker – click here for settings 

 

PPpoker – (Private clubs, invites required) – click here for settings 
 
 
Suprema Poker – (Private clubs, invites required) – click here for settings 
 
 
iPoker Network – click here for settings (Bet365 / Titan / Betfair / Red Star / Betsson / 

William Hill / Betsafe / NetBet / Holland Casino / Bet365.it / Titanbet.it /  Betclic / etc.) 

 

 

  



Ignition Casino, Bovada, & Bodog Poker 
 
1. On the Table Settings tab make sure the red background, default deck, and the 
black card back are selected. 
 

 
 

  



 
 
 
2. On the Game Play Settings tab under Game Play Setting you should match the 
following settings.  
 
The most important things here are to have Disable Pop to Front unchecked and to 
have Stack values displayed as big blinds unchecked! 
 
 

 



  
 
 

3. Still on the same Game Play Settings tab, but now under Seating, make sure Do 
Not Use Preferred Seating is unchecked. Please note this is a different instruction 
now than we gave for past versions of their poker client. 
 
In addition, set the preferred seat for each table type as bottom-center, unless there is 
no bottom center seat in which case set it as bottom-right. 
 
 

 
 
 
 

4. On the Default Buy-in tab Auto-Post Blind should be enabled (although this is not 
critical for bot play). 
 

 
 
 
 
 
 
 



 
 
 
5. Finally, the first time you open a table close the sidebar window on the right side, 
before starting the bot. Our bot cannot play if this is open. Please note this entire 
window must now be closed, including the chat, not just the mini-games on top. 
 
Do this by clicking the little arrow on the right side. You should only need to close this 
once, the first time you open a table. 
 

 
 
 
Start the bot after you take a seat at a poker table! Simply click the start button on the 
bot menu. To stop it, click the stop button. 
 
Watch the bot after you first start it and make sure it is reporting the correct Big Blind 
size and your correct stack size. If not, or if you experience any other problems, please 
read the more detailed instructions in the Holdem Bot User Manual included in the 
bot folder, which is located at C:Poker\data (see here for easy access). 
 
To play multiple tables see the multi-tabling instructions here. 
  



 
 
 
 
Ignition / Bovada / Bodog Troubleshooting 
 
  
* No sidebar on the poker table window -- click the arrow in the middle of the right side 
to collapse it completely. Please note this has recently changed and now the entire 
window must collapse, not just the mini-games on the top half. 
  
* You must always be in the bottom center seat, and must use preferred seat view to 
stay there. Double-check your Ignition/Bovada settings to make sure they match with 
the ones shown in the screenshots in the Easy Start Guide PDF. 
 
* Make sure no other software is running/open when the bot plays (including web 
browsers, Teamviewer, etc), and minimize the lobby. 
  
* If you are using a dual monitor please disable it completely and use only the first 
monitor. Similarly, if using a laptop do not attempt to use an external monitor -- use the 
laptop screen. Also, TV screens and "convertible" laptop-tablet hybrids usually do not 
work. We recommend a single standard non-touch screen monitor (although laptops 
with touch screens often work as long as they are not a convertible tablet, especially if 
there is an option to disable the touch screen). 
  
* Your screen display must be on "100%" (not 125%). Right-click on your desktop, go 
to Display (or Personalize > Display on Windows 7) and make sure this is set to 
"100%" or "100%, Smaller." 
  
* Your windows language must be set to English/US and you must be using English 
language in the poker room client. 
  
* If running Windows 7 please use the default "Aero" Windows theme. 
  
* Finally, you can try playing with your resolution setting and see if you find one that 
works better. 
 

  



 
iPoker Network  Including but not limited to: Bet365 / Titan & TitanBet / Betfair / 

William Hill / Betsson / NetBet / Paddy Power / Boyle / Holland Casino / Red Star / 
Betclic.fr / Parion Sport Poker / Bet365.it / Titanbet.it / Sisal.it / Bet365.es 
 
Important Note: If there is a side games bar next to the poker table it must be 
closed for the bot to work at all iPoker sites! 
 
The following poker room settings adjustments are all critical. 
 
1. On the General tab choose Classic Mode and disable as many of the other options 
as you can stand. Less things showing on the table or popping up is better for the bot. 
 

 
 
 
 
 
 
 
 
 
 
 
 



 
2. On the Avatar tab disable player avatars. This is critical. 
 

 
 
3. Set your Themes tab to use the Abstract style cards & 2-Color deck: 
 

 



 

 
Scroll down on the Themes tab and select the first green felt table on the list. For 
some sites this will be the Default table: 
 

 
 

 
For other sites it will be the Classic table style. 
 

 
 
 

 
 
 
 
  



Still on the Themes tab, finally, you must set the Action Buttons to Default: 
 

 
 
 
4. On the Animations tab turn off all animations! 
 

 



 
5. Set your Table tab to disable just about everything but Highlight table: 
 

 
 

 
 
While still on the Tables tab click Configure Betting Buttons: 
 

 
 

  



 
 
Important: You must configure your betting buttons as follows: 
 

 
 

Buttons 2 and Buttons 3 must be configured for Pot and Max as shown.  
 
Button 4 must be set to Disabled as shown. 
 
Button 1 does not matter. 
 
  



 
6. Set your Multi Tables tab to select all three Steal focus options only: 
 

 
 

 
 
7. If the site offers a Player HUD tab, disable the Player HUD! 
 
8. Close any sidebars in the poker table window! These vary by site. Only the poker 
table must be in the poker table window! If there is a sidebar, there will be a button to 
close it so the poker table expands to occupy the entire window. 
 
Start the bot after you take a seat at a poker table! Simply click the start button on the 
bot menu. To stop it, click the stop button. 
 
Watch the bot after you first start it and make sure it is reporting the correct Big Blind 
size and your correct stack size. If not, or if you experience any other problems, please 
read the more detailed instructions in the Holdem Bot User Manual included in the 
bot folder, which is located at C:Poker\data (see here for easy access). 
 
To play multiple tables see the multi-tabling instructions here. 
  



 

Additional stealth measures now recommended for iPoker sites.  

Some iPoker sites have recently started giving us trouble, after many years of leaving 

us alone. These simple extra steps will keep them from finding the bot on your PC if 

they happen to be snooping. 

 
1. Rename the “Poker” folder on your C: drive to something else. You could also then 
choose to move the folder somewhere else, such as inside one of your Windows 
folders in your Program Files. You should also rename the “data” subfolder inside it. 
 
2. Delete the desktop shortcut (Do not neglect this step! Do not simply rename the 
shortcut!) 
 
3. You now need to rename the bot file, which is named holdembot.exe located in 
your newly-renamed folders. If you desire a desktop shortcut, create a new one by 
right-clicking on the renamed app and choosing Send to > Desktop (create shortcut). 
You will then need to right-click on the new shortcut, go to Properties > Advanced and 
set the new shortcut to always Run as Administrator. Or you can just remember to 
always open it to run as administrator from the mouse right-click menu. 
 
4. Open your Downloads folder now and delete our Installer app. 
 
5. When you receive your license, keep it inside the renamed bot folder alongside the 
renamed bot app, not on your desktop or on your C: drive.  
 
6. Probably a good idea to keep the bulk of your bankroll in an offsite-wallet and 
deposit frequently as needed.  
 
 
 
 
  



iPoker Troubleshooting 
  
* No sidebar in the poker table window. There should only be a poker table; if there is 

any kind of sidebar please find the button to click to make it vanish or minimize to the 

side. This includes "mini games" and casino game ads. They can't be there. 

 * Stack size must be displayed in currency, meaning real money, not by the number of 

big blinds! 

* Green table felt (at some sites this is the "default" table style -- at others it is "classic" 

table style, but if you are having trouble try switching to the other). 

* If "Auto Center my seat" is an option (on the Table tab or elsewhere) enable this 

* Player avatars are disabled, right? These cannot be showing on the table. 

* Animations are all turned off, right? See screenshot in our latest PDF setup 

instructions. 

* Abstract card style and Default action buttons style! Right? 

* If Player HUD is an option, make sure it is disabled! 

* Display DPI on your PC is set to 100%  

* Windows language set to English/US (Italian rooms are the exceptions)  

* English speaking version of the poker client (Italian rooms are exceptions) 

* Configured the betting buttons in the poker client properly, as shown in our PDF 

screenshots, for Pot and Max 

* For 8-player tables (including tourneys using 8-Max tables) please manually adjust 

the Option setting on the bot as follows: Options > Max Players Allowed at Table > 8 

 * Not using a dual monitor, right? Or an external monitor hooked to a laptop? Or a TV 

screen as a monitor? (A dual monitor, if even hooked to the tower, may need to be 

disconnected completely.) Please note "convertible" laptop-tablets with a touch screen 

do not usually work, either. We recommend a single standard non-touch screen 

monitor (although laptops with touch screens often work as long as they are not a 

convertible tablet, especially if there is an option to disable the touch screen). Update: 

Unfortunately, "all in one" PCs seem to be problematic as well. We recommend a 

spare laptop or a traditional PC tower hooked to a standard-size monitor.  



PPpoker  
 
Please note that emulators (such as Bluestacks etc.) are not supported. You must use 
a Windows PC and the Windows download of PPpoker. If you live in a country where 
the Windows download page (PPpoker.net) is blocked, you can use a free VPN to 
download it. We recommend Windscribe and any Europe IP address such as France. 
 

Important: You must rename the poker bot file (in the file folder location, not the 
desktop shortcut) or this platform will block you when you start the bot with a 
“prohibited software detected” message.  
 
You also must delete the original desktop shortcut (to holdembot.exe) or PPpoker 
will see it and block your access. But that is all they do, and we have supported them 
for 8+ months since they started doing it and bans are rare. Your funds should be safe 
with your agent and club owners never ban anyone. 
 
The fix is easy: 
 
1. Right-click the original desktop icon and select Open file location 
 
2. Rename the file holdembot.exe to something like Skype.exe 
 
3. Create a new desktop shortcut to the renamed bot: Right-click and select the menu 
item Send to > Desktop (create shortcut) 
 
4. Delete the original desktop shortcut to holdembot.exe 
 
5. Set the new desktop shortcut (to Skype.exe, or whatever) to Run as Administrator: 
Right-click, go to Properties, click on the Advanced button, check box to Run as 
Administrator, and save. Or you can just remember to always open it to run as 
administrator from the mouse right-click menu. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

https://windscribe.com/


Required PPpoker Settings: 
 
1. Close the initial log-in window (by clicking the X in the upper right corner) to get 
to the first option settings screen. Here, select the 338 x 600 table size and also the 
English language. 
 
 

 
 
 
 
 
 
 
 
 
 
 

2. Once you are logged in, go to any poker table. From the poker table, click the 
hamburger menu in the upper left to get to Table Settings. Then you need to take care 



to match the settings shown below. Especially make sure that Card Squeeze is 
disabled, and that Exact Betting is enabled. 
 
 
 

 
 

 

 
 
 
 
 
 
 



3. On the Game Settings tab make sure you are using the 2-Color deck and the 
green table felt (both of these are the default setting). The bot cannot see the 4-color 
deck or play on a different color felt! 
 
 
Beeping: When the bot encounters something that needs your attention (such as a 
captcha puzzle to solve or the “rebuy chips” screen) it will make your PC beep at you. 
So if you are in the area and hear the PC beeping when the bot is playing at PPpoker, 
you need to scoot over to your PC and handle it to avoid being removed from the table. 
 
That’s it (as long as your PC Display setting is 100%). 
 
PPpoker Troubleshooting List (updated) 
 
If you are having trouble make sure: 
  
• Your PC "Display Setting" is set to 100% 
 
• PPpoker Table size is set to 338x600 (set this BEFORE you log in, click the little X) 
 
• PPpoker language is English 
 
• 2-Color Deck (not 4-color) which is the default, and default green table felt (under 
Game Settings, you must set that from an open table) 
 
• Card Squeeze and Card sort are disabled (under Table Settings) 
 
• Customized Action Buttons are DISABLED (under Table Settings) 
 
• Exact betting is ENABLED (under Table Settings) PPSR Tables Nor Supported 
 
• Disable Game stats if the club has them 
 
• No dual monitor, do not use a TV screen as a monitor or an external monitor on a 
laptop, do not use a convertible laptop-tablet, do not use an 'all-in-one' PC. 
  
• Original desktop shortcut was deleted, not just renamed, bot .exe program file was 
renamed, and any then newly-created desktop shortcut is running "as administrator" 
 
If you still need help, contact us by email and we will come on by Anydesk to help with 
your PPpoker setup. 
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Start the bot after you take a seat at a poker table! Simply click the start button on the 
bot menu. To stop it, click the stop button. 
 

Watch the bot after you first start it to make sure it is reporting the correct Big Blind 
size and your correct stack size. If not, or if you experience any other problems, please 
contact us by email or forum. 
 
To play multiple tables see the multi-tabling instructions here. 
 
  



 
Suprema Poker  
 
 

Please note that emulators (such as Bluestacks, etc.) are not supported. You must 
use a Windows PC and the Windows download of Suprema poker. 
 
This is one of those platforms that just works out of the box, with no setting 
adjustments required on your part as long as your PC Display is correct (especially 
your Display set to 100%) and language settings are English. Just don’t change 
anything from the default Theme Setting, below. All table types are supported: 6-max, 
8-max, and 9-max. Table changes are followed automatically in MTTs. 
 

Default Suprema Poker Theme Setting: 
 

 
 



 
 
 
Multi-tabling here is trickier, however, and only recommend for advanced users. It 
requires logging into multiple accounts. This is because additional tables for the same 
account open up within the same window, and thus shrink the table sizes too small for 
our bot to read the screen info. But when you log into a second account and open a 
table, that opens in its own separate window so our normal multi-tabling instructions 
can then be followed. 
 
Beeping: Cash games on this platform will occasional require a captcha puzzle be 
solved. When the bot encounters one of these, it will make your PC beep at you. So if 
you are in the area and hear the PC beeping when the bot is playing, you need to 
scoot over to your PC and handle it. 
 
Rebuys & Top-ups can be set on the app itself to be handled automatically. 
 
Run it Multiple Times is supported, but cannot be adjusted. The bot will always offer 
to “Run it Twice” and always accept an opponent’s offer to run it multiple times. 
 
Double-board games are not supported. 
 
 
Start the bot after you take a seat at a poker table! Simply click the start button on the 
bot menu. To stop it, click the stop button. (You can load a profile at any time, but 
probably best to load one before starting.) 
 
Watch the bot after you first start it to make sure it is reporting the correct Big Blind 
size and your correct stack size. If not, or if you experience any other problems, please 
contact us.  



 
 

Supplemental Instructions 
 
 
1. The Bot folder was installed at C:Poker\data. Open this by going to Computer (or 
your system folders), then Local Disk (C:) then open the Poker folder and finally open 
the data folder. All the bot files are here, including several good profiles we gave you in 
text format, besides the default profile that auto-loads in the bot (which is also good). 
 
When you open the bot folder, you will see the bot program named holdembot or 
holdembot.exe. You can create a desktop shortcut by right-clicking and choosing  
 

Send to > Desktop (Create shortcut) 
 

 
 
For easy bot folder access, from the Holdem Bot desktop shortcut right-click and 
select Open File Location. 
 
Back to Instructions 
  



 

On your PC the Windows language must be set to English / United States (unless 
you live in Italy) and the Display DPI setting must be 100% (not 125%). 
 
From your computer’s Control Panel go to Clock, Language, and Region. 
 

 
 
Open the Region and Language settings. On the Formats tab set the language to 
English (United States) if needed: 
 

 
 
(Note: you may also need to change the keyboards tab there to US). 
 



Next, Right-click on an empty space on your desktop and select Personalize (on 
Windows 7) or Display (on Windows 10) from the mouse menu that pops up. 
 

 
 

 

On Windows 7 in the lower left corner of the screen find Display and click on it. (On 
Windows 10 you will already be there directly). 
 
On the screen that comes up make sure your Display setting is on 100%, the smaller 
setting (some Windows 10 machines recommend 125%, but the bot cannot use it). 
 

 
 

 
On Windows 10 please disable the Smart Screen filter. See this page for easy 
instructions: https://windowsable.com/easy-way-to-disable-windows-smartscreen-in-
windows-10/  
 
 
Back to Instructions 
 
 

https://windowsable.com/easy-way-to-disable-windows-smartscreen-in-windows-10/
https://windowsable.com/easy-way-to-disable-windows-smartscreen-in-windows-10/


 
 

Multi-Tabling Instructions 
  
To play additional tables you need to open additional bot windows and then attach 
those to new poker tables one at a time. You must open the additional bot windows 
from the bot menu item Holdem > New Window. A new bot window will appear. Each 
time you click that, up to the six max allowed. 
  
Choose profiles for the new bot windows with the Read Profile function. This will not 
affect the profiles in use at any other open bot windows. Each bot window operates 
independently. So you can have the bot play an SNG with one profile at the same time 
it plays a cash game with a different profile. 
  
Only one unhooked poker table can be available on your screen when you start the 
new bot window. It will automatically attach itself to whatever table is open that has no 
other bot instance connected to it. There cannot be two poker tables open that do not 
have bot windows attached to them, or the bot won’t know which one to hook to. For 
this reason, you must hook new bot windows to them (by pressing start on the bot) one 
at a time. Multiple bot windows can be opened in advance, however. 
  
The Hide button hides all the bot windows at once. So, when multi-tabling, minimize 
the bot windows that are already attached first, and when you have started as many 
tables as you want, then hide all the bot windows at once. 
  
Table Positioning Tip: If you have a big screen you should try to position the tables so 
there is minimum overlap between them. On smaller screens, you should at least 
position the tables such that the button areas do not overlap. Tables do not actually 
need to be visible for the bot to work and they can all overlap if necessary, but it is best 
if overlapping buttons do not occupy the same screen space. 
  
If the bot cannot connect to the additional table on its own, it will ask you for the name 
of the new table. Be sure to spell it correctly and make sure you capitalize the right 
letters. Try to do this as quickly as possible.  
  
Repeat the process for opening a third and fourth table if desired, to a maximum of six 
tables (unless restricted to fewer tables by the poker site).  
  
To stop: First quit the poker game in the normal manner and close the poker room 
software. Then bring back all bot windows with the appropriate Alt+F commands and 
close them. 
 

 

Back to Instructions 



 
Profile Info 
 
The process for loading a profile in the bot is: 
 

Holdem > Read Profile > (select the one you want and click Open)  

Here is some info on how the profiles that come in the bot play: 
 
6-Pack: Load this one for 6-max cash tables. It plays a LAG-style game (loose-
aggressive) without becoming hyper-aggressive. Buy in for a full stack. 
 
Little Green: Based on the style taught in Phil Gordon's book, this profile will push with 
draws and strong hands on the flop, so is best used in cash games and is good at full 
9/10 player tables that have low player turnover, because we want them to see when 
we push with a draw and go on tilt when we make it. Buy in for around 70% of a full 
stack for best results. 
 
Wild Bill: A hyper-aggressive cash game profile that tightens up when its stack size 
reaches 150 big blinds. It is important to only buy in for a half-stack with this profile 
(you can also short-stack with it). 
 
The Fixer SNG: A 1-table (STT) sit-n-go profile that knows when to pressure your 
opponents with 3-bet pre-flop pushes and also plays the bubble intelligently.  
 
MTT: One of our favorite tournament profiles. Use in MTTs or SNGs (but be aware that 
200 hands may not be enough to finish the event if you are still running the demo). 
 
Default profile: Do nothing to use this one as it loads by default. Its name is Doodle 
and it plays a typical TAG-style (tight-aggressive) so is best at low stakes, full 9 or 10-
player cash tables. A good choice to simply evaluate how the bot functions if you can 
find a full 9/10-max table going.  
 
xTestOnly: Use this one only to test the bot functions, to make sure your settings are 
correct so the bot can bet and raise. When this profile is loaded it will make the first bet 
or raise at every opportunity preflop and on the flop. After seeing that the bot is 
working right, switch to another profile! (Unless you are in a crazy game at PPpoker in 
which case this profile may actually win.)  
 
 
Back to Instructions 
 
 


